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Vantage Cloud Port 
Overview

This chapter presents an overview of Vantage Cloud Port—its features, components, 
and typical applications—to help you get started, and understand how you can use 
Vantage Cloud Port in your Vantage-based media processing systems.

Topics
■ Getting Started

■ Typical Cloud Port Applications

■ Understanding the Types of Vantage Workflows

■ Extending a Vantage Domain to Telestream Cloud

■ Vantage Cloud Port Workflow Pricing

■ Monitoring Cloud Port Billing in Telestream Cloud

■ Managing Telestream Cloud Accounts and Assets

■ Canceling a Telestream Cloud Account

Note: This guide is written for video professionals who are familiar with using 
Vantage and focuses on Vantage Cloud Port features in Vantage. All other aspects of 
Vantage configuration and use are covered in the other Vantage user guides.

If you aren’t familiar with Vantage, we suggest that you read the Vantage User Guide 
and Vantage Domain Management Guide.

Before using Cloud Port features, you should be familiar with:

• Designing and constructing workflows in Vantage Workflow Designer, including 
the role and use of variables and media nicknames in workflow. 

• You should be familiar with decision making and branching workflow execution. 

• Vantage Secured Version Control, which maintains version integrity for workflows. 
For details, see the Using Vantage Secured Version Control app note.

This guide focuses on creating and using Cloud Port workflows in Telestream Cloud. All 
other aspects of Vantage configuration and utilization are covered in the other Vantage 
guides.

http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/Vantage-User-Guide.pdf
http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/Vantage-User-Guide.pdf
http://www.telestream.net/pdfs/app-notes/app-Secured-Version-Control.pdf
http://www.telestream.net/pdfs/app-notes/app-Secured-Version-Control.pdf
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Getting Started
Vantage Cloud Port expands the power of your Vantage domain to include Cloud 
services. Whether your domain is a single-node Vantage domain or a multi-node array, 
with Cloud Port, you have access to flexible, scalable media processing power in 
Telestream Cloud.

Topics
■ Overview

■ Typical Cloud Port Applications

■ Use Cases Not Well-suited for Cloud Port Workflows

Overview
Vantage Cloud Port is a set of features that enables—and interfaces with—Vantage 
services that are hosted in Telestream Cloud—and executed by cloud-capable actions in 
Cloud Port workflows. These actions enable Vantage domains to leverage additional 
Cloud processing on demand. Whenever workload peaks or other requirements demand 
it, using Vantage Cloud Port to extend your domain to cloud-based media processing 
only requires a few changes to a Vantage domain and your workflows.

Here are the key features and benefits of Vantage Cloud Port:

• Works in new or upgraded Vantage domains for workflow creation and execution
• Deploys action execution to Telestream Cloud using containerized micro-services 

with functionality identical to the on premises edition of the services
• Enables seamless execution of Vantage workflows wherever needed. Cloud-capable 

actions can run on premises or in Telestream Cloud, and workflows can be designed to 
shift processing to the Cloud automatically when workload exceeds a threshold.

• Workflows can be deployed on premises or in Telestream Cloud
• Enables easy modification of existing workflows to run in Telestream Cloud
• Enables easy startup and scaling of additional cloud-based Vantage resources
• Provides additional cloud processing power on demand economically.

Typical Cloud Port Applications
Vantage Cloud Port workflows (hybrid and hosted) generally, are ideally suited for 
Vantage users who...

• Want to leverage new or existing on premises Vantage domains and workflows

• Need to respond quickly to rapid changes in demand for Vantage processing

• Want to save money and time by accessing Vantage software as a service (SaaS) 
instead of investing in additional on premises hardware to meet peak demand

• Want occasional access to specialized features without requiring a license

• Want the simplicity of cloud processing that “just works” whenever you need it.
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Ideal Use Cases for Hosted Workflows
Hosted Workflows—workflows specifically designed for hosting and execution directly in 
Telestream Cloud, are ideally suited for Vantage users who...

• Have media located on cloud storage (Amazon S3, Google Cloud Storage, Azure 
BLOB storage). Maintaining files in the cloud typically is not a significant opera-
tional cost. Greater costs typically arise when you move files out of the cloud. Con-
sider designing your workflows so as to minimize the number (or frequency) of files 
that are downloaded.

• Primarily want to submit cloud-resident media for cloud processing via a third 
party program or system via an API:

• Have materially variable workload—for example, on most days you typically 
transcode a few hundred files; but each Thursday, you typically transcode about 
1500 files for weekend consumption.

• Require dynamic scalability: efficient, concurrent processing high volumes of jobs 
is critical to your operation.

• Value total throughput over total transcoding time per job. For example, you need 
to transcode about a thousand files as a batch (potentially concurrently), but it isn’t 
important that it takes 15 minutes longer per file, for example.

Use Cases Not Well-suited for Cloud Port Workflows
It is equally important to understand the scenarios which may not be beneficial to 
migrating from a Vantage on-premises workflow to a Vantage Cloud Port hybrid or 
hosted workflows

Vantage Cloud Port workflows are not recommended for users who...

• Are processing on-premises repositories of extremely large or highly-dense media 
files. The time and cost of uploading these to cloud storage may be prohibitive or 
offset the potential savings of cloud processing.

• Are downloading high volumes of transcoded media back on-premises—Vantage 
Cloud Port workflows may not be ideal due to the egress costs/fees incurred.

• Require high throughput of individual jobs—that is, highest possible entire work-
flow execution speed and fastest turn-around time. Cloud Port workflows typically 
will not match the speed that is enjoyed by GPU acceleration on a Vantage Light-
speed server. If you are required to process a particular asset in a fixed amount of 
time, these workflows may not be the best option when compared to processing 
the asset in an on-premises Vantage domain hosted on Lightspeed servers.

• Workflows which require interaction/inter-operation with fixed assets may not be 
candidates for Telestream Cloud hosted workflows (for example, if a workflow inte-
grates or is tightly coupled with an on-premises Watermarking service).

• Submitting jobs the way you typically submit jobs on-premises: work orders, hot-
folder ingests of local, on-premises media, drag, drop, and forget jobs, and jobs 
submitted via Vantage TrafficManager or other Workflow Portal applications.
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• Transcoding extremely large or 4K and higher format files which reside on prem-
ises—the cost of uploading the file to the cloud may be prohibitive.

• Delivering transcoded media back on premises—egress costs may be prohibitive.

• Individual job throughput—transcoding each job as quickly as possible is critical

• Have applications that require operator intervention. For example, paired work-
flows with an operator using Workflow Portal to view/trim/update metadata before 
submitting the media for final processing.
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Understanding the Types of Vantage Workflows
Cloud Port expands the scope of a Vantage domain to include Telestream Cloud, and 
enables you to create two different types workflows—hybrid workflows and hosted 
workflows. All workflows, regardless of type, are designed in Workflow Designer. Some 
actions require a specific license.

Hybrid Workflows
Hybrid Workflows are workflows that are hosted directly in your on-premises Vantage 
domain and managed in Workflow Designer, but include one or more actions that can 
execute in Telestream Cloud at run time.

In addition to Vantage actions in hybrid workflows that only execute on premises, these 
workflows include cloud-capable actions, which may execute in Telestream Cloud 
when in Cloud Port mode. They may also include Cloud Flip | Cloud QC | Cloud Speech | 
Location actions, which only execute projects implemented in Telestream Cloud. For 
information on creating and using hybrid workflows, see Creating Hybrid Workflows.

Telestream 
Cloud

Vantage Engine Containers Vantage Engine Cloud Execution

Control & Status

Control 
& Status

Media
Cloud Storage 

S3 / Blob

Vantage 
Domain

Vantage EngineAPI
Integration

On-Prem Storage

Post 
Producer

Flip64 IPTV Timed 
Text Flip

Analysis
Multi-
screen
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Hosted Workflows
Hosted Workflows are intended for hosting and execution directly in Telestream Cloud, 
without any dependencies on Vantage after the creation and configuration phase. Only 
certain media processing actions (see Using Cloud-capable Media Processing Actions) 
can be utilized in hosted workflows, and the execution of these actions is governed by 
your Vantage Cloud Port service contract and billing system.

Note: Before you can execute hosted workflows in Telestream Cloud, a Telestream 
Cloud account is required with active Cloud Port service, and a cloud storage account, 
registered for utilization in Telestream Cloud (See Vantage Cloud Port Requirements).

Vantage Cloud Port hosted workflows enable you to expand your on-premises Vantage 
solutions into intelligent, cloud-native media transformation engines. You design these 
powerful, automated workflows using Vantage Workflow Designer, and then export 
and deploy them to Telestream Cloud where they can be accessed and executed from 
anywhere in the world. 

Decentralized access to your own cloud-based media processing applications with no 
single point of failure changes the game, expanding horizons for your media 
processing requirements.

Hosted workflows are exported to Telestream Cloud after they have been designed in 
Workflow Designer. Hosted workflows are a subset of hybrid workflows, where the 
supported set of utility actions supported is limited. See Using Cloud-Capable General-
Purpose Actions.
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Once a workflow has been validated and exported as a Compiled Workflow Document 
(*.cwd) file and uploaded to Telestream Cloud; the on-premises Vantage domain is only 
required to modify or update the workflow or create new workflows.

Unlike hybrid workflows, hosted workflows are managed using the Telestream Cloud 
console.

Jobs are typically submitted via a Cloud Port API-based client program or system. They 
may also be submitted via the Telestream Cloud console.

Action execution occurs exclusively in Telestream Cloud. These workflows can only be 
comprised of cloud-capable actions, which all execute in Telestream Cloud. Hosted 
workflows can not include Cloud actions: Cloud Flip | Cloud QC | Cloud Speech | 
Location.

 For details on creating and using hosted workflows, see Creating and Deploying Hosted 
Workflows.
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Extending a Vantage Domain to Telestream Cloud
With the advent of Vantage Cloud Port, the concept of a Vantage domain expands to 
include all Telestream Cloud components that inter-operate with an on premises 
Vantage domain. 

• Hybrid and hosted workflows interact with Telestream Cloud to provide seamless 
media processing and data storage provided by supported Cloud storage vendors. 

• When cloud-capable actions are in Cloud Port mode, they display pricing per con-
tent minute. When these actions execute in Telestream Cloud, you are charged for 
action execution by the content minute.

• Workflows can be enabled to determine automatically whether to process locally or 
in the cloud—based on your media location and domain utilization (workload).

• Vantage displays processing status for both on premises and cloud-based actions.

Telestream Cloud Processes and Features
• Telestream Cloud hosts version-matched Vantage services to execute these actions: 

– Analysis

– Conform

– Flip64

– IPTV Flip

– Multiscreen Flip

– Tempo

– Timed Text Flip.

• Media can be stored on-premises or in supported third-party Cloud storage: Ama-
zon AWS, Microsoft Azure, and Google Cloud Storage. 

• Media that is already in the cloud, stays in the cloud. Local (on premises) media is 
transferred automatically to the cloud for cloud-based processing.

• When activated by a workflow, Telestream Cloud rapidly spins up a Vantage Engine 
Container and processes the media in the cloud.

• Many jobs process simultaneously, based on dynamic Telestream Cloud scaling.
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Prerequisites
Before you start designing Cloud Port hosted workflows in Vantage and deploying 
them to Telestream Cloud, make sure that you have met these prerequisites:

• Vantage 8.0 Update Pack 4 or later, plus any Component Pack releases must be 
installed and operative. A Vantage domain where hosted workflows are created 
and configured requires all Vantage services to installed and running.

• Your on-premises Vantage domain must be kept up to date with the latest Compo-
nentPacs. Cloud Port utilizes the ComponentPac revision of each cloud-capable 
action in a workflow to determine which version of the Telestream Cloud service to 
use when it executes the job in Telestream Cloud.

• A Telestream Cloud account is required to utilize Vantage Cloud Port. If you don’t 
have one, in Chrome, go to https://cloud.telestream.net to create a a free trial 
account. 

• A cloud storage account is required to use any feature of Telestream Cloud. If you 
don’t have an account with one of these cloud storage providers: Amazon S3 | Goo-
gle Cloud | Microsoft Azure, create one and become familiar with using it.

Note: See Getting Vantage Cloud Port Up and Running in the Cloud Port User’s Guide for 
a comprehensive description of all Vantage domain and Telestream Cloud 
requirements and configuration, and how to create cloud storage and Telestream 
Cloud accounts, and register them in Vantage and Telestream Cloud so that they can 
be accessed and utilized during workflow execution.

https://cloud.telestream.net/
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Vantage Cloud Port Workflow Pricing
Pricing is per-action for cloud-capable actions—those that process media essences 
directly (see Using Cloud-capable Media Processing Actions). Prices displayed in 
Workflow Designer are based on pre-discount list prices. These prices are only 
approximate and should not be used to calculate or estimate actual fees. Prices for data 
transfers are not included in these usage fees, which if applicable, will be charged by 
your cloud storage provider in addition to Telestream Cloud usage fees.

Telestream may change its prices at any time without prior notice. When multiple 
outputs are produced by a single action, actual charges for this action will be based on 
the longest output produced by this action. When variables have been bound to fields 
such as width and height, the calculated prices displayed in Vantage are based on the 
default value of the variable.

A number of factors affect pricing. For example, these are some Flip64 pricing factors:

• Video Compressor or direct-conversion

– Height, Width, Frame Rate

– Multi-Pass encoding

– Custom Interlacing Rules

• Certain output packagers incur an additional charge.

• Dolby encoding and decoding incurs an additional charge. (Dolby AC-3 decoding 
pricing does not display on the action; it is determined at runtime.)

See Monitoring Cloud Port Billing in Telestream Cloud for details on viewing Telestream 
Cloud billing.
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Monitoring Cloud Port Billing in Telestream Cloud
Users who have Vantage Cloud Port access in Telestream Cloud can view usage and 
billing:

1. Log into Telestream Cloud.

2. Choose Vantage Cloud Port from the Dashboard.

3. Select Analytics. The display shows your usage for the specified time period and 
provides filtering to view only the data you want to see.

Please note that this is not a bill. It simply shows the approximate amount of charges 
incurred to date. You will receive a separate monthly bill or a credit card charge from 
Telestream.

For additional information about how Vantage Cloud Port pricing is determined based 
on workflow execution, see Vantage Cloud Port Workflow Pricing. If you have any 
questions or need additional details about billing, please see Canceling a Telestream 
Cloud Account.
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Managing Telestream Cloud Accounts and Assets
A Telestream Cloud account is required to utilize Vantage Cloud Port.

When you are ready to establish your Telestream Cloud account, in Chrome, go to 
https://cloud.telestream.net and start your free trial account.

Instructions later in this guide explain how to establish a Telestream Cloud account 
(Creating Your Telestream Cloud Account). 

Canceling a Telestream Cloud Account
To cancel your Telestream Cloud account and discontinue billing, please contact 
Telestream Cloud Support using one of the methods in the contact list, preceding.

https://cloud.telestream.net/
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Getting Vantage Cloud 
Port Up and Running

This chapter focuses on meeting Cloud Port requirements in Vantage, creating a Cloud 
storage account and a Telestream Cloud account, and configuring Vantage and 
Telestream Cloud to utilize Cloud Port—all the tasks required to get Vantage Cloud Port 
up and running after you’ve installed or updated your Vantage domain.

Note: Utilization of Cloud Port requires Vantage 8.0 UP2 or later. Vantage installation/
updating is not described in this guide. For full details, see the Vantage Domain 
Management Guide, which is published on the Telestream Web site.
To make best use of Cloud Port, you should frequently check for new Update Pack and 
ComponentPac releases and update your Vantage domain to utilize the functionality 
that is provided, which may lift some restrictions (see Configuration Limitations in 
Cloud Port Mode).

Topics
■ Vantage Cloud Port Requirements

■ Creating a Cloud Storage Account

■ Creating Your Telestream Cloud Account

■ Configuring Vantage for Cloud Port

https://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/VantageDomainManagement.pdf
https://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/VantageDomainManagement.pdf
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Vantage Cloud Port Requirements
These are the accounts, services, and products you’ll need in order to implement a 
Cloud Port-enabled Vantage domain and use it to process your media.

Note: Your Vantage domain must have high-speed Internet access (not dial-up or 
satellite) in order to utilize Vantage Cloud Port and Telestream Cloud.

Third Party Cloud Storage Account
Vantage Cloud Port uses your third-party cloud storage account for accessing your media 
and storing processed output files. You will need an account on Amazon AWS, Google 
Cloud Storage, or Microsoft Azure. (See Creating a Cloud Storage Account.) 

Telestream Cloud Account
Establish an account in Telestream Cloud (https://cloud.telestream.net). To create this 
account you’ll need your Cloud storage account information, so create your Cloud 
storage account (immediately preceding) first if you haven’t already done so.

Once you’ve created a Telestream Cloud account (see Creating Your Telestream Cloud 
Account) and select a billing method. You enter your storage account and credentials in 
Telestream Cloud so that Vantage Cloud Port can access your storage.

Vantage Domain
You can execute cloud-capable Vantage actions in Telestream Cloud from a new or an 
upgraded on premises Vantage 8.0 UP2 (or later) single-node domain or array. For 
Vantage domains platform requirements, see the Vantage Domain Management Guide. 

Using Vantage Cloud Port on a single-node domain requires a license Vantage Cloud 
Port Designer license (V-SW-VANTAGE-START) or any other license which allows 
workflow design and activation, such as Transcode (V-XCODE-SW) or higher. Actions 
placed into Cloud Port mode are licensed for per-minute cloud execution. 

Note: The Utilization action, used to manage workload between the cloud and on 
premises actions, requires a Vantage Array Pro license.

For software or licenses, visit www.telestream.net and choose Vantage from the Buy 
menu. 

https://cloud.telestream.net
http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/VantageDomainManagement.pdf
http://www.telestream.net/
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Creating a Cloud Storage Account
A third-party cloud storage account is required to use Vantage Cloud Port. Vantage 
Cloud Port supports Amazon AWS, Google Cloud Storage, and Microsoft Azure. 

See the instructions for a summary of how to set up an account with the supported 
vendor of your choice. If you need help, refer to the documentation on the vendor’s 
web site. Instructions are also summarized on the Telestream Cloud site storage page.

Topics
■ Cloud Storage Considerations

■ Creating an Amazon AWS Account

■ Creating a Google Cloud Account

■ Creating a Microsoft Azure Account

Cloud Storage Considerations
• Performance may vary by the type of storage resource you choose. Network traffic 

during busy times may affect storage performance and transfer speeds.

• Virtual servers can become temporarily unavailable. If Vantage Cloud Port has trou-
ble accessing your storage, visit your storage web site to determine whether your 
storage is inaccessible for some reason. Be sure to verify your credentials.

• Default storage account settings specify limits on various resources. If you bump up 
against the limits and need greater speed or additional storage, contact your stor-
age provider for assistance.

• Normally, cloud-capable actions automatically transfer source media for processing up 
to a target cloud storage bucket. The files are placed into the vcp-uploads folder in your 
output storage bucket. However, when using Post Producer CML files or other refer-
ence sources such as IMF and using a storage bucket for input source material, you 
should identify the specific source input bucket used in Telestream Cloud, so that Van-
tage and Telestream Cloud know where to find the input media files being referenced.

Creating an Amazon AWS Account
Follow these steps to create an Amazon storage account:

1. Go to https://aws.amazon.com and follow the instructions in Sign Up.

2. Once your AWS account has been created, go to Amazon Simple Storage Service 
(S3) in the management console and sign up for the service.

3. Go to IAM Users settings (Services > IAM > Users) to create a Telestream Cloud user.

4. Copy the generated user credentials (Access Key ID and Secret Access Key). You’ll 
need these later to configure Vantage Cloud Port in Telestream Cloud.

5. Read Cloud Storage Considerations below and continue on to Creating Your 
Telestream Cloud Account to enter your credentials to access your storage.

https://aws.amazon.com
https://docs.telestream.dev/docs/user-guides-storage
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Creating a Google Cloud Account
Follow these steps to create a Google Cloud Storage account:

1. Go to the Google Console (https://console.cloud.google.com/) and follow the sign-
up instructions to create a new account.

2. After signing into your new account, create a GCS project.

3. In the project, select APIs & AUTH in the left sidebar.

4. In the APIs list, click the button next to Google Cloud Storage to turn GCS on.

5. In the project Settings click Enable billing and follow the steps.

6. Obtain and copy your Access Key & Secret Access Key as follows:

a. Go to your project’s Storage page.
b. Under Cloud Storage select Storage access from the left menu.
c. Click the Interoperability tab on top. You may need to click the Enable 

Interoperability access button to enable the tab. 
d. On the Interoperability tab, find and copy your Access Key & Secret Access Key.

7. Read Cloud Storage Considerations and then continue on to Creating Your Telestream 
Cloud Account, where you will enter your credentials to access your storage.

Creating a Microsoft Azure Account
Follow these steps to create a Microsoft Azure storage account:

1. Go to https://www.azure.com and click the green Start Free button and follow the 
prompts to create a new account. 

2. After logging into the Azure Portal, click Storage Accounts.

3. Click Add to begin creating a new storage account.

4. Click Create Storage Account and make entries and selections in required fields.

5. Click Review + Create, and verify your selections are correct and validated.

6. Click Create. You will receive a deployment complete message.

7. Select your storage account > Overview > Access Keys.

8. Copy your access keys for use in setting up your Vantage Cloud Port account.

9. Read Cloud Storage Considerations below and then continue on to Creating Your 
Telestream Cloud Account, where you’ll enter the credentials to access your storage.

https://console.cloud.google.com/
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Creating Your Telestream Cloud Account
To use Vantage Cloud Port, you create a Telestream Cloud account with Vantage Cloud 
Port access enabled. This is where your cloud-based processing occurs. If you have an 
existing account, you can use that without creating a new one.

Note: Before you sign up for an account, you should have a third-party storage 
account that you want the Telestream Cloud account to access for storage. See the 
details in Creating a Cloud Storage Account to create a storage account.

Topics
■ Cloud Account Prerequisites

■ Creating a Telestream Cloud Account

Cloud Account Prerequisites
The following prerequisites apply to setting up a Telestream Cloud account:

• A high speed Internet connection (not satellite or dial-up) to your Vantage server 
and to the server used to create your Telestream Cloud account.

• An Internet browser for signing up and managing Telestream Cloud.

• A third-party cloud storage account with Amazon AWS, Microsoft Azure, or Google 
Cloud Storage.

Creating a Telestream Cloud Account
1. Point your browser to https://cloud.telestream.net. Click Start Free Trial or Sign Up.

Once your account is established, you can click Login on this page to access your 
account.

Click Start Free 
Trial or Sign Up

https://cloud.telestream.net
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1. Fill in the form to establish an account. You will receive an email confirmation 
notice. Follow the instructions to verify your account by email.

2. Fill in the Welcome form to complete your account information, and click Take me to 
my dashboard. 
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3. Select Dashboard in the main menu and click Get Started (bottom left).

4. A get started page indicates that you are signing up for a Telestream Vantage Cloud 
Port account. On this page, you can select a billing method. 

5. Click Select Payment Method to select credit card or direct billing by Telestream. 

Click Get Started

Select Payment 
Method.

Click Finish when 
done with pricing 
and billing.
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6. If you select credit card, a card details page displays. Fill in your card details, and 
click Finish. Wait until you are notified of service activation.

7. When billing activation is complete, select Dashboard and Vantage Cloud Port.
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8. Your Vantage Cloud Port Overview page displays. Click the user menu in the upper 
right corner and select IAM. 

9. The IAM page shows your Telestream Cloud Access Key, Secret Key, and API Key 
under Legacy API Access.

If you have multiple users, you can create multiple keys, one for each user, using the 
Add API Key button.

10. Note these keys for use in configuring Vantage.
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11. Click your user name in the upper right corner, and select Manage Stores to open 
the Data Store page.

12. On the Data Store page, click +Add Store to open the Add New Store page.

13. On the left side of the page, select the type of store you plan to use with Vantage 
Cloud Port (Google, AWS, etc.).
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14. If using AWS, select Use Access Key and Secret Key or Use AWS IAM Role. (The Use AWS IAM 
Role page is shown above, and the Use Access Key and Secret Key page is shown below.)

Note: You must grant some form of cloud storage access so that Telestream Cloud 
can read and write media and other files to and from your storage.

If you choose Use Access Key and Secret Key, you must fill in your AWS keys. These keys 
are used only once to modify the AWS Access Control List (ACL) to enable Telestream 
Cloud access to your bucket as needed.

As an alternative if you prefer not to supply your keys, choose Use AWS IAM Role, which 
allows Telestream to use the AWS STS service to create temporary credentials to access 
your store each time. If you choose this method, you must also configure Telestream 
Cloud access using the AWS Security Token Service. See this AWS help link for details: 
https://docs.aws.amazon.com/STS/latest/APIReference/Welcome.html.

15. Fill in your store account information so that Vantage Cloud Port can access your 
account to read and write files. The information fields requested vary depending on 
the selected store. For information about a field, hover over the blue “i”.

16. Click Add Store to complete storage setup.

This completes Vantage Cloud Port configuration in the Telestream Cloud. Go to the 
next topic to configure Vantage and create workflows.

https://docs.aws.amazon.com/STS/latest/APIReference/Welcome.html
https://docs.aws.amazon.com/STS/latest/APIReference/Welcome.html
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Configuring Vantage for Cloud Port
This topic describes how to add your Telestream Cloud account to Vantage, so it can 
integrate with it, and adding your cloud storage account to Vantage, so that it can read 
and write in it. 

Topics
■ Vantage Installation and Licensing

■ Adding your Telestream Cloud Account to Vantage

■ Adding your Cloud Storage Account to the Vantage Folder Address Book

Vantage Installation and Licensing
1. If you haven’t yet installed Vantage and licensed it, install and license it now, so that 

you can configure it for Vantage Cloud Port operation. Install or upgrade to a 
licensed Vantage 8.0 UP2 or later installation as explained in the Vantage Domain 
Management Guide.

During installation or upgrade, ensure that the Vantage domain includes the Cloud 
Service, all services corresponding to the cloud-capable actions, and the latest 
ComponentPacs.

These are the Vantage services required on Vantage Cloud Port. Be sure each is 
selected (checked) for installation when you run the Vantage installer:

– Cloud Service

– Transcode Service

– Timed Text Service

– Analysis Service

– Multiscreen Service

– IPTV VOD Transcode Service

– Edit Service

Note about the Cloud Service: In a Vantage array, each node that has Vantage’s 
Telestream Cloud Service and at least one other Vantage service which also installs a 
ComponentPac (such as the Vantage Transcode Service) can processes Cloud jobs.

2. Verify that all the services are running (Online) in the Vantage Management 
Console > Services. If not, right-click and select Restart Service. 

Notes: While examining the Vantage Services in the Vantage Management Console, 
pay particular attention to the Cloud Service Setup.

The Cloud Service includes an Upload Limit that throttles concurrent cloud file 
uploads to prevent overloading your cloud storage. The default is four concurrent files. 
You can set the service to maintenance mode and then display the Cloud service 
Setup tab to change the Upload Limit value.

http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/Vantage-User-Guide.pdf
http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/Vantage-User-Guide.pdf
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The Cloud Service also has unique Session Limit requirements. It should be set equal 
to the number of concurrent jobs allowed for Telestream Cloud. For example, if your 
Telestream Cloud account is set to a limit of 30 jobs (the default) and the Vantage 
domain consists of 2 nodes, the session limits of the Cloud services in each Vantage 
array node should be set to 15. If the Cloud service is set to a session limit higher than 
the capacity of the Telestream Cloud account, the jobs will be shown as in process in 
Vantage and queued in Telestream Cloud. If you need a higher concurrent jobs limit, 
contact Telestream Cloud Support and request an increase. 

3. If a license is not available, contact Telestream Sales for licensing and install the 
license as explained in the Vantage Domain Management Guide.

Adding your Telestream Cloud Account to Vantage
1. Open the Vantage Management Console > Settings & Options > Telestream Cloud tab.

2. Click the yellow key icon to add a new Telestream Cloud account.

3. Enter a name (such as the authorized user name) for the Telestream Cloud account. 

4. Enter the Telestream Cloud API Key you noted previously on the Telestream Cloud 
IAM page (see Creating a Telestream Cloud Account).

5. Click Test to make sure your connection to your Cloud account is operational.

6. Click Save to update your Telestream Cloud account credentials in Vantage.

Adding your Cloud Storage Account to the Vantage Folder 
Address Book

In order for Vantage and Telestream Cloud to inter-operate with your cloud storage, the 
storage location and credentials must be entered into Telestream Cloud > Cloud Store 
and in the Vantage Folder Address Book. If you use more than one cloud storage site, 
make a separate entry for each in Telestream Cloud and in the address book.

https://www.telestream.net/purchase/store.htm
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Additional Notes on the Vantage Folder Address Book
When Cloud Port mode is enabled in a workflow action, you should specify which cloud 
storage account to use, and Vantage will automatically access the address book entry 
instead of using a local Vantage Store. The cloud storage location is then used both for 
copying the source file to the cloud prior to processing and for storing transcoded 
output files after processing.

The Vantage Folder Address Book is used by Vantage Cloud Port to ensure URL 
compatibility between Telestream Cloud and Vantage. When Telestream Cloud places 
material in cloud storage, it refers to the material using a signed URL, which is typically 
a secure HTTP link that expires within 24 hours. These references must be translated to 
a native Vantage URL to allow downstream Vantage actions to perform all of the 
required native file system operations on the media reference. The Vantage Folder 
Address Book entry enables this translation for a Cloud Port mode enabled action. 
Without the Vantage Folder Address Book entry and associated translation, the 
interaction among Vantage, Telestream Cloud, and cloud storage may not work.

To add your cloud storage to the Vantage address book, follow these steps:

1. In the Vantage Management Console, select Storage > Vantage Folder Address Book.

2. Click the Add Folder icon 

3. Give the folder exactly the same name as the name you used for your cloud storage in 
your Telestream Cloud account Data Store.

4. Click Modify... to specify the Location.
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5. Select the type of cloud storage (file system) from the Folder Location Editor window.

6. Enter your cloud storage account information, such as access keys and bucket name.

Important: The credentials used in the Vantage address book entry MUST match 
exactly the credentials used to access your third-party storage location and the 
credentials used in Telestream Cloud > Cloud Store for that storage location. As an 
example, for S3, you must use the same Access Key ID, the same Secret Access Key, and 
the same bucket reference in all three locations. If there is a credential mismatch in any 
of these locations, Vantage Cloud Port will not work.
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7. Enter the folder location on the cloud server. Your default location is already noted, or 
you can browse or enter a UNC path to another folder.

8. Click Finish to complete the address book entry.
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Designing Cloud Port 
Workflows

This chapter explains how to design and deploy Vantage Cloud Port workflows. This 
identifies cloud-capable actions, and focuses on creating hybrid and hosted workflows, 
and exporting workflows for execution in Telestream Cloud.

Topics
■ Using Cloud-capable Media Processing Actions

■ Using Cloud-Capable General-Purpose Actions

■ Creating Hybrid Workflows

■ Creating and Deploying Hosted Workflows

■ Troubleshooting
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Using Cloud-capable Media Processing Actions
Cloud-capable actions are transcoding or other media processing actions that are 
implemented to execute in Telestream Cloud in the same manner as they do in a 
Vantage domain. Due to cloud platform constraints, there are some limits when 
configured to execute in Cloud Mode.

Note: If you modify workflows that were created in a version of Vantage that is not 
capable of—or licensed for—Cloud Port and Telestream Cloud, you will be reminded 
when you try to enable Cloud Port mode to upgrade the action first. To upgrade all of 
your workflows and actions at once, in Workflow Designer select File > Batch Workflow 
Operations > Check for Upgrades, and then choose Upgrade.

Vantage services that implement Cloud-capable actions are configured in the Vantage 
Management Console > Services panel > Setup tab. In particular, the Cloud Service 
Upload Limit controls the number of concurrent cloud file uploads and the total of this 
number for all nodes should be set to match the concurrent job limit set by Telestream 
Cloud (30 is the default).

Vantage Cloud Port tracks source files that have been uploaded for Cloud-capable 
actions to prevent the same file from being uploaded multiple times. For example, if 
you have a file at a given location, such as D:\Folder1\foo.mpg, and you submit this 
file to a cloud-capable action twice, the file will only be uploaded once.

If the file is deleted from cloud storage and it is submitted to Vantage again, it will be 
uploaded a second time.

If the file is submitted to a cloud-capable action that targets a different cloud store, the 
file will be uploaded to the second store.

If the file is submitted from a different location (for example, D:\Folder2\foo.mpg), the 
file will be uploaded again.

To upload the same file for each job, use a Copy action in the workflow preceding the 
cloud-capable action, for example: Receive > Copy (to a specific bucket) > Flip64 (same 
bucket).

■ Configuration Limitations in Cloud Port Mode

■ Media Transcoding and Processing Actions

Configuration Limitations in Cloud Port Mode
During the design phase, once you enable at least one Cloud-capable action to operate 
in cloud mode, each time you save an action or export the workflow (as a hosted 
workflow), the workflow is automatically verified to operate in Telestream Cloud. 

Note: To make best use of Cloud Port, you should frequently check for new 
ComponentPac releases and update your Vantage domain to utilize the functionality 
that is provided, which may lift some restrictions.
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If unsupported actions are added to the workflow or an action is configured in a way 
that violates the limits imposed by being a Cloud-capable workflow, Workflow 
Designer displays an error. For example:

These features and configurations are not compatible with cloud-capable media 
processing actions:

• H264 or H265 presets slower than Medium

• Encoded frame sizes greater than DCI 4K

• Multi-pass encoding

• The Camera decoder

• Microsoft Smooth Streaming Packager

• Adobe HTTP Dynamic Streaming Packager

• Analysis action outputs for WebVTT, SCC, and SMPTE 2051 TTML. 

• Analysis of Omneon User Data

• VP9 Video encoding

• Keyframe (.jpg) encoding

• Advanced Title Processor (Conform action)

• Watermarking: Nielsen, Kantar, Teletrax, NexGuard

• Actions which make use of static resources or reference on-premises resources.

You should ensure that all references to resources are either removed, modified to use 
cloud-hosted resources, or replaced by variables. You should make sure that actions are 
configured in a valid configuration which allows Cloud Port mode. 

For example, a workflow with a Flip64 action which references a static overlay file 
(D:\MyImages\myfile.png for example), will obviously not execute beyond the specific, 
on-premises environment in which it was built.

Actions which reference specific on-premises locations (for example, a Flip64 action 
configured to write output to a network folder) are also invalid.

• Some containers and formats supported in Vantage actions executed on premises 
may not be available in Cloud Port mode. If you select a container or format not 
supported in Cloud Port mode, an error message informs you that it is unavailable.

• Actions in Cloud Port mode should be configured to use the Multi-core Video Pro-
cessor.
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Media Transcoding and Processing Actions
The following media processing actions may be executed on-premises in your Vantage 
domain or in Telestream Cloud. You can use these cloud-capable actions in both hybrid 
and hosted workflows:

■ Analyze Action

■ Cloud Flip Action

■ Cloud QC Action

■ Cloud Speech Action

■ Conform Action

■ DPP Validate Action

■ Flip64 Action

■ IPTV Flip Action

■ Multiscreen Flip Action

■ Tempo Action

■ Timed Text Flip Action

Cloud-capable media processing actions are charged by the media minute. See 
Vantage Cloud Port Workflow Pricing for details. 

Note: The following are general action descriptions. Some action features executable 
on premises may not be executable in Telestream Cloud. Workflow Designer displays a 
message if you try to use an action feature that is not available. For full operational and 
configuration details, see the man page for the target action.

Analyze Action
The Analyze action (in the Analysis category) is Cloud Port capable. It is executed by the 
Analysis service on-premises or the Telestream Cloud Service in hosted workflows. It 
can perform many kinds of analysis on media using a variety of analysis tools, and 
populate variables for use downstream. For example, the action can detect black, color 
levels, interlacing, letterbox, slate, scene changes, audio levels, and much more. 

Cloud Flip Action
The Cloud Flip action is Cloud Port capable. It is executed by the Vantage Cloud service 
on-premises or the Telestream Cloud Service in hosted workflows. The Cloud Flip action 
submits media from Vantage workflows via the Telestream Cloud Service and the 
Telestream Cloud API to the Telestream Cloud for transcoding. To use the Cloud Flip 
action you must have a Telestream Cloud account and enter the account credentials in 
the Vantage Management Console Settings to enable Vantage to access the account. 
When the Cloud Flip action executes, the input file is uploaded and processed 
according to the Cloud Flip factory chosen in the Cloud Flip action, and the results are 
returned to the workflow for downstream use.
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Cloud QC Action
The Cloud QC action is Cloud Port capable. It is executed by the Vantage Cloud service 
on-premises or the Telestream Cloud Service in hosted workflows. The Cloud QC action 
submits media from Vantage workflows via the Telestream Cloud Service and the 
Telestream Cloud API to the Telestream Cloud for quality checking. To use the Cloud QC 
action you must have a Telestream Cloud account and enter the account credentials in 
the Vantage Management Console Settings to enable Vantage to access the account. 
When the Cloud QC action executes, the input file is uploaded and processed 
according to the Cloud Quality Control project chosen in the Cloud QC action, and the 
results are returned to the workflow for downstream use.

Cloud Speech Action
The Cloud QC action is Cloud Port capable. It is executed by the Vantage Cloud service 
on-premises or the Telestream Cloud Service in hosted workflows. The Cloud Speech 
action submits media from Vantage workflows via the Telestream Cloud Service and 
the Telestream Cloud API to the Telestream Cloud for speech-to-text conversion. To use 
the Cloud Speech action you must have a Telestream Cloud account and enter the 
account credentials in the Vantage Management Console Settings to enable Vantage to 
access the account. When the Cloud Speech action executes, the input file is uploaded 
and processed according to the Cloud Timed Text Speech project chosen in the Cloud 
Speech action, and the results are returned to the workflow for downstream use. 

Conform Action
The Post Producer Conform action (in the Edit category) is executed by the Edit service. 
This action assembles and optionally transcodes multiple video and still image files into 
a single output file, applying filters you specify. The input files and related instructions 
for the output file are all defined in a Composition XML file. 

Note: Because of font rendering differences between Windows and Linux, if a Cloud 
Port mode Conform action CML specifies a text shadow or over-line effect, these 
effects are ignored and are not rendered in the output. Font information included in 
the Timed Text Flip description also applies to fonts specified in a Conform CML.

When the Conform action is in Cloud Port mode, the source CML file may reference 
media in cloud storage only if the following conditions are true:

• The Vantage Folder Address Book must have an entry for the bucket/blob container 
containing the media.

• The Telestream Cloud account must have a store for the bucket/blob container con-
taining the media.

• The CML file must be submitted to the Conform action from a UNC or local Win-
dows path (for example, D:\source.cml or \\server\source.cml). 

The CML may refer to a file in storage by the nickname, short URL, or long URL. 

Example 1 refers to a media file nicknamed Original:
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<File location="{$#Original}"/>

Example 2 refers to a media file nicknamed Image: 

<Image layer="1" align="both" adjust="body" location="{$#Image}" 
fill="loop" duration="00:00:02.000">

Example 3 refers to the short URL of a media file in S3 cloud storage. In the third 
example, s3://ts-us-east-2-ohio is an S3 bucket, oes-sources is a folder within the bucket, 
and 1min.mov is the media file name:

<File location="s3://ts-us-east-2-ohio/oes-sources/1min.mov"/>

Example 4 refers to vantageblobstore as the Azure storage account name, ts-cloud-test 
as the blob container name, and 2min.mov as the file name.

<File location="azure://vantageblobstore.blob.core.windows.net/
2min.mov?containerName=ts-cloud-test"/>

Example 5 refers to ts-vantage as the Google bucket name, and 2min.mov is the file 
name.

<File location="gcs://ts-vantage/2min.mov"/>

Example 6 shows the case where you may need to use the full URL to the file. 

https://accountname.s3.us-west-1.amazonaws.com/FAA_Short 1.mp4?X-
Amz-Algorithm=AWS4-HMAC-SAH256&X-Amz-Content-Sah256=UNSIGNED-
PAYLOAD&X-Amz-Credential=AKIAIYVKOY43MTXXXXXX%2F20190423%2Fus-
west-1%2Fs3%2Faws4_request&X-Amz-Date=20190423T231319Z&X-Amz-
Expires=7200&X-Amz-SignedHeaders=host&X-Amz-
Signature=9bac488f32ab94ffe88c096962f6cdcf2c04845d8a18df0bd4abfe

To view and copy the full URL in Workflow Designer:

1. View the job output that produced the file in Job Status Views.

2. Double-click the job to open the binder. 

3. Right-click the Output. 

4. Select View Full URL.

5. Click in the URL and use Ctrl-A or scroll and highlight to select all. 

6. Right-click Copy to put the URL into the clipboard for pasting to another location. 
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Note: If a reference file or CML file that references more than 32 files is submitted to a 
cloud-capable action, the job will fail at run time, indicating that this is not supported.

DPP Validate Action
The DPP Validate action is Cloud Port capable. It is executed by the on-premises or the 
Telestream Cloud Service in hosted workflows. You can use the DPP Validate action to 
confirm compliance of a DPP metadata XML file. If the XML file passes validation, TRUE 
is generated; otherwise FALSE is generated. You can test the results of the action 
downstream to change the workflow’s actions based on the validation results. 
Optionally, you can also generate a report when executing on-premises.

Flip64 Action
The Flip64 action (in the Transcode category) is executed by the Vantage Transcode 
service and is a 64-bit multi-core-optimized encoder that transcodes media from one 
or more input files into another format as specified by the output configuration. 
Available resolutions extend from SD to UltraHD and 4K in a broad range of file formats. 

IPTV Flip Action
The IPTV Flip action (in the IPTV/VOD category), is executed by the Vantage IPTV VOD 
service. This action is designed to generate MPEG2 Transport Stream files and meet 
multiplexing requirements. The IPTV Flip action and IPTV VOD Service support the 
features required to handle varying IPTV, set-top box and cable encoding requirements, 
and ancillary metadata specific to cable ad splicing and cable/IPTV set-top box 
environments. 
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Multiscreen Flip Action
The Multiscreen Flip action (in the Multiscreen category) is executed by the Vantage 
Multiscreen Service and is designed for encoding and packaging decoded digital 
baseband media into industry-standard adaptive rate streaming formats, including 
Adobe HDS, Apple HLS, Microsoft HSS, and others. 

Tempo Action
The Tempo action is part of the Edit group and executed by the Vantage Edit Service. 
The Tempo action is included in Tempo, a time-adjusting encoding solution built on 
the Vantage platform. The Tempo action uses the Edit Service for re-timing file-based 
content and intelligently decreasing or increasing the running time of shows and 
segments. 

Timed Text Flip Action
The Timed Text Flip action (in the Timed Text category) is executed by the Vantage 
Timed Text service to automate caption file-type conversions, embed captions, extract 
captions from media containing embedded captions, create subtitle overlay graphics, 
and manipulate the timecode of caption data to match media. 

Supported Fonts

These fonts may be used with the Timed Text Flip action in Cloud Port mode. If you select a 
font that is unavailable in Cloud Port mode, you will not be able to enable Cloud Port mode 
and an error message will explain that the selected font is not available.

• Andale_Mono.ttf—Regular, Mono

• Arial.ttf—Regular, Black, Bold, Italic, Bold Italic

• Comic_Sans_MS.ttf—Regular, Bold

• Courier_New.ttf—Regular, Bold, Italic, Bold Italic

• Georgia.ttf—Regular, Bold, Italic, Bold Italic

• Impact.ttf

• Times_New_Roman.ttf—Regular, Bold, Italic, Bold Italic

• Trebuchet_MS.ttf—Regular, Bold, Italic, Bold Italic

• Verdana.ttf— Regular, Bold, Italic, Bold Italic

• Webdings.ttf

Fonts render differently in Windows vs. Linux operating systems. Subtitles or other on-
screen print renderings that use the fonts built into the OS may result in print output 
from the cloud (Linux) that differs from the same output on Windows. In particular, font 
size, font spacing, font effects and anti-aliasing may have subtle differences on the two 
platforms. If you require a specific font style with Cloud Port, Telestream recommends 
waiting until NewBlue support is added to Linux.
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Using Cloud-Capable General-Purpose Actions
A subset of general-purpose/utilitarian actions are implemented in Telestream Cloud. 
These actions execute in Telestream Cloud in the same way as they do in an on-premise 
domain. There is no per-action charge for executing these actions in Telestream Cloud. 
These actions are not explicitly configured to run in Cloud mode; they do not display 
the Cloud mode badge, either.

 The following actions are supported in hosted workflows:

• Compute

• Construct

• Decide

• Extract

• Multi-Decide

• Notify with HTTP Notifier

• Receive

• Synchronize

Note: When you utilize these actions in a hybrid workflow, they automatically 
execute on premises; in hosted workflows they of course execute in Telestream Cloud. 
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Using Variables and Parameters in Cloud Port 
Workflows

Cloud Port workflows can utilize variables in the same manner as on-premises 
workflows. Workflows that use expected variables—variables that are not created or 
updated internally upstream—can only be used by a job submission method that is 
capable of supplying values for these variables (parameters in the case of API 
submission) at run time.

For hybrid workflows, you can submit jobs from another workflow, a work order, from 
Workflow Portal, or from a third party program using the Vantage API. For hosted 
workflows, you can only submit jobs via an API-based program or system.

Note: Detailed information about parameter binding and variable manipulation is 
provided in the Vantage User Guide and Vantage Rest API Guide.

For example, here is an IPTV/VOD action where the x264 codec’s resolution is being set 
by variables instead of constants:

To view expected variables—variables that are utilized in a workflow but are not set by 
default or set within the workflow, expand the Properties of the workflow panel (using 
the open/close arrow just to the left of the workflow title). 

http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/Vantage-User-Guide.pdf
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In this case, two variables are expected (these correspond to the two variables which 
were bound to the Width/Height parameters of the IPTV action).

To submit a job to this workflow, the job-submission program must be designed to 
obtain these two values, update variables and submit them with the job request.



Designing Cloud Port Workflows
Creating Hybrid Workflows

46

Creating Hybrid Workflows
This topic explains how to design hybrid workflows in Workflow Designer to use Cloud 
Port features.

Note: Before you can process media in Telestream Cloud, you must have set up your 
Telestream Cloud account, a third-party cloud storage account, and your Vantage 
domain settings for Cloud Port operation as explained previously.

■ Hybrid Workflow Restrictions

■ Monitoring Utilization to Design Effective Hybrid Workflows

■ Creating a Prototype Hybrid Workflow

■ Verifying and Using Hybrid Workflows

Hybrid Workflow Restrictions
A hybrid workflow is one that contains cloud-capable media processing actions, but 
remains hosted directly in an on-premises Vantage domain and is managed in 
Workflow Designer. Hybrid workflows have the following characteristics and limits:

• Hybrid workflows—unlike hosted workflows—can start with any origin action.

• In addition to containing Vantage actions that only execute on premises, a hybrid 
workflow must include at least one cloud-capable action.

• Cloud-based output files generated from cloud-capable actions can be operated 
on using Vantage Transport Service actions: Copy | Move | Delete | Deploy.

• Cloud-capable or Telestream Cloud action, and Cloud Port mode must be enabled.

• Certain configuration limitations apply to cloud-capable actions. See Configuration 
Limitations in Cloud Port Mode.

•  Hybrid workflows may include Telestream Cloud actions—Cloud Flip | Cloud QC | 
Cloud Speech | Location actions—which always execute projects implemented in 
Telestream Cloud.

• Files uploaded to cloud storage for transcoding are stored in the vcp-uploads folder 
in your cloud storage account. This enables you to easily track uploaded files and 
delete them after you no longer need them. Files in this folder must be managed 
manually.

Monitoring Utilization to Design Effective Hybrid 
Workflows

The Vantage Utilization action (n the Common group in Workflow Designer) is an optional 
feature which requires an Array Pro license. It enables you to determine the current 
utilization of the Vantage domain or transcoding actions and report the results in a 
variable, one for each metric being tested.
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The variable emitted by the Utilization action represents the percentage of utilization 
for each checked metric. The variable can be used in downstream Decide actions to 
control the flow of work through the workflow. The variable can also be passed out of 
the job was well, for external recording or reporting, for example.

These metrics can be used to determine how to efficiently handle the workload by 
directing the workflow to execute one branch or another, including routing to a branch 
with actions are configured to execute in Telestream Cloud, when on premises services 
approach saturation

The following figures show Utilization action configuration and an example workflow.

For example, if you want to route IPTV VOD actions based on current resource 
utilization to an on premises domain server running the IPTV VOD service or to a cloud-
based IPTV VOD resource, you can submit a job to a workflow that executes a 
Utilization action to test the IPTV VOD load. 

If the result is lower than the maximum workload threshold, the workflow can trigger 
the on premises IPTV VOD action. However, if the load is higher than the threshold, the 
workflow can trigger a cloud-mode-enabled IPTV VOD action that transcodes the 
media in Telestream Cloud. 
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1. When the workflow completes, check Vantage Job Status for success or failure. If 
there is a failure, Vantage Job Status and your Telestream Cloud account provide 
details about what happened.

2. If you have access to the Vantage Cloud Port account in Telestream Cloud, click 
Dashboard > Vantage Cloud Port. 

The Jobs Overview displays each job and its status details:
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3. Click the Workflow Name or Vantage Job Name to see details about the job.

4. Finally, check the binder (right-click the job and select View Binder) and the cloud 
storage for expected output files (AWS S3 example shown). 

Creating a Prototype Hybrid Workflow
To create a hybrid workflow, in Workflow Designer, follow these steps:

1. Create a new workflow. 

2. Include one or more cloud-capable | Telestream Cloud actions to execute in 
Telestream Cloud.

Note: The Output Location for a cloud-based media processing action is not used and is 
disabled. The output always is written to a cloud location (specified in Cloud Port mode).
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3. Enable cloud processing for a cloud-capable action: right-click the action and select 
Cloud Mode > Configure Cloud Mode. 

4. In the Vantage Cloud Port Setup dialog, check Enable Vantage Cloud Port Mode to 
activate cloud execution for this action. Configure the fields:

After media is processed, the output file is pushed to the target cloud storage loca-
tion. To prevent output file names from colliding in the target cloud store, use Spec-
ify subfolder path in storage to specify a unique location.

5. Select your Telestream Cloud account, select your cloud storage, and specify a 
subfolder path, if any, where you want the output file to be stored. Click the drop-
down menu and select any variables to include for automatic subfolder naming. 

6. Click OK to save your entries and close the window.
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Important: For a cloud-capable action to execute, the required accounts and 
credentials must be correct in all of these locations:

• Telestream Cloud—You must have a valid Vantage Cloud Port account, and you 
must include correct third-party storage credentials on the Data Store page.

• Third party cloud storage—You must have at least one valid cloud storage account. 

• Vantage Management Console > Settings & Options > Telestream Cloud—You 
must enter the name of your Telestream Cloud account and its API key.

• Vantage Management Console > Vantage Folder Address Book—You must enter 
the exact name and keys for your third-party cloud storage accounts.

• Action Cloud Port mode—You must select your Telestream Cloud account and your 
cloud storage account from the drop-down menus in the Vantage Cloud Port Setup 
dialog.

Verify your credentials carefully in all places. If credentials are entered incorrectly in any 
of these locations, Vantage Cloud Port may not function properly. 

To review your cloud storage and Telestream Cloud configurations, see Creating a Cloud 
Storage Account and Creating a Telestream Cloud Account.

To review your Vantage settings, see Adding your Telestream Cloud Account to Vantage 
and Adding your Cloud Storage Account to the Vantage Folder Address Book for details.
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When Cloud Port mode is set up correctly, the cloud-enabled action shows a Cloud Port 
mode indicator and the price per content minute. (Actions in Cloud Port mode are billed 
on output media duration, except for Analyze, which is billed on source media duration.)

This example is simplified to present just the basics of Vantage Cloud Port workflows. 
However, these workflows can be as complex as you need, including analysis, decision-
making, and branching. You can include any action or number of actions downstream 
of the cloud-capable action. For example, you can use a Copy action to localize a 
transcoded file out of the cloud, or use a Deploy action to send the file to another 
server or storage location. Because Vantage knows file locations based on nicknames, 
subsequent actions only require the nicknames to find and process cloud files. 

Verifying and Using Hybrid Workflows
When workflow design is complete, follow these steps to verify operation:

1. Activate the workflow, submit a job, and monitor the job in the Job Status tab. 

2. Vantage receives the source file, and the cloud-capable action copies it to the cloud 
storage location you specified when you configured Cloud Port mode, placing the 
source file into a vcp-uploads folder. 

3. From the vcp-uploads folder, the cloud-capable action processes the source file 
and places the output file in the cloud storage location.

4. Any actions downstream of the cloud-capable action operate as they normally 
would do. These actions use the nickname to find the processed file in the cloud 
and continue processing.

5. Use the Job Status tab to monitor processing status: Uploading (input to cloud 
storage), Queued, Processing, and Pushing (output to cloud storage). Note that 
actions cannot be paused, even though Vantage may indicate that you can do so.

Cloud Port mode
Enabled Indicator

Price indicator



Designing Cloud Port Workflows
Creating and Deploying Hosted Workflows

53

Creating and Deploying Hosted Workflows
This topic explains how to design hosted workflows in Workflow Designer and deploy 
them to Telestream Cloud for execution independent of Vantage, using Telestream 
Cloud’s Cloud Port service.

Note: Before you can process media in Telestream Cloud, you must have set up your 
Telestream Cloud account, a third-party cloud storage account, and your Vantage 
domain settings for Cloud Port operation as explained previously. 

■ Hosted Workflow Restrictions

■ Creating a Prototype Hosted Workflow

■ Deploying Hosted Workflows to Telestream Cloud

Hosted Workflow Restrictions
A hosted workflow is one that is designed in Workflow Designer, validated and 
exported as a CWD file, and deployed to Telestream Cloud for complete execution with 
no dependency on your Vantage domain. 

It is managed in the Telestream Cloud console. Often, jobs are submitted and also 
managed via a Cloud Port API-based program.

Hosted workflows differ from hybrid workflows in that they have a more restricted set 
of actions that are supported, and also have the following characteristics and limits:

• Hosted workflows can only start with a Receive origin action.

• They must be able to execute successfully on-premises (in your Vantage domain). 
Testing on premises requires that you change the location of output files, of course. 

• Use only cloud-capable actions: 

– Cloud-capable transcoding actions, which must be configured to meet 
Telestream Cloud service capabilities. See Using Cloud-capable Media Processing 
Actions.

– A limited set of utility actions that have been implemented in Telestream Cloud. 
See Using Cloud-Capable General-Purpose Actions.

• You do not (should not, for consistency sake) enable Cloud mode on the transcod-
ing/media processing actions; the entire workflow (when imported) executes in 
Telestream Cloud and the Cloud mode settings must be configured directly in 
Telestream Cloud.

• All the same configuration limitations apply to cloud-capable actions used in 
hybrid workflows. See Configuration Limitations in Cloud Port Mode.

• Hosted workflows can not include Cloud actions (Cloud Flip | Cloud QC | Cloud 
Speech | Location). Unsupported (and incorrectly configured) actions are flagged 
when you export your workflow.
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• Actions (transcoders, for example) that generate files require you to configure the 
lifespan of the output file, because the workflow is executing outside the context of 
Vantage, which has automatic file lifespan management, whereas Telestream Cloud 
does not. 
When Telestream Cloud (not Vantage) is executing the workflow, a Delete action 
can’t be used to delete files created by action in the workflow. When Telestream 
Cloud executes workflow jobs, it uses the output lifespan setting to delete all tran-
sient files at the end of the workflow execution. (Lifespan settings are ignored when 
workflows execute locally, whether the Cloud-capable actions execute locally or in 
Telestream Cloud.)

– Transient—choose when the media created by this action is temporal—it is only 
used by other actions in this workflow, and should be automatically deleted 
immediately after the workflow (the job) has completed.

– Permanent—choose when the media should be retained (not deleted) after the 
workflow has completed. In this case, file management is beyond the scope of 
the workflow, Vantage, or Telestream Cloud.

• An action can’t generate multiple files with different Output Lifespan settings. For 
example, an IPTV/OVD action can’t generate one file which is Permanent and 
another which is Transient. If you require multiple outputs with different lifespans, 
add an action for each, and set this action’s output lifespan accordingly.

Creating a Prototype Hosted Workflow
In this prototype, the Conform action ingests the CML file, performs the requisite 
transformation from CML and produces an intermediate version, passing it to IPTV Flip. 
Using the IPTV Flip action, a cable-compliant media version is generated as the target 
output. 

To create a hosted workflow, follow these steps, using this prototype as an example:

1. Open Workflow Designer and create a new workflow within the limits of Hosted 
Workflow Restrictions.
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2. Add a Receive action (the only origin action permitted for hosted workflows) to 
start the workflow, and configure it with the nickname to use for accessing your 
source media version.

3. Add a Conform action and configure it.

The purpose of this workflow is to produce a Cable-compliant version of the media 
as defined by the incoming CML file, nicknamed Original. The generated output of 
the Conform action (nicknamed Transient) only has a useful lifespan within the con-
text of this workflow, as input to IPTV Flip. As such, the intermediary file Transient 
isn’t useful once this workflow job is complete. (A file with this temporal character-
istic is referred to as being transient.)

Contrast this to the generated output of the IPTV Flip action. This action emits an 
output file nicknamed Cable. This the version of the media that you intend to utilize 
in production for example, or have an indefinite lifespan beyond job execution. A 
file of this temporal characteristic is referred to as Permanent.
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4. Because this is a hosted workflow executing in Telestream Cloud, in order to delete 
the temporal file, right-click on the action and choose Cloud Mode > Output 
Lifespan. 

5. In the Output Lifespan dialog, select Transient and close the dialog.

6. Finally, add an IPTV Flip action and configure it. 

The purpose of this action is to produce a Cable-compliant version of the media as 
defined by the incoming CML file, nicknamed Original. The generated output of the 
IPTV/VOD action (nicknamed Permanent) in contrast, has a useful lifespan within 
the context of this workflow, as input to IPTV Flip. 

7. Specify the Output Lifespan as Permanent.

Summary
This prototype is simplified to present just the basics of Vantage Cloud Port hosted 
workflows. However, these workflows can be as complex as you require, including 
analysis, decision-making, and branching. 

You can include any action or number of actions upstream or downstream of cloud-
capable actions. For example, you can use a Copy action to localize a transcoded file 
out of the cloud, or use a Deploy action to send the file to another server or storage 
location. Because Vantage identifies file locations based on nicknames, subsequent 
actions only require nickname to identify, locate, and process cloud-resident files. 

Important: For a cloud-capable action to execute successfully, the required accounts 
and credentials must be correct in all of these platforms and programs:

• Telestream Cloud—You must have a valid Vantage Cloud Port account, and you 
must include correct third-party storage credentials on the Data Store page.

• Third party cloud storage—You must have at least one valid cloud storage account. 

• Vantage Management Console > Settings & Options > Telestream Cloud—You 
must enter the name of your Telestream Cloud account and its API key.

• Vantage Management Console > Vantage Folder Address Book—You must enter 
the exact name and keys for your third-party cloud storage accounts.
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• Action Cloud Port mode—You must select your Telestream Cloud account and your 
cloud storage account from the drop-down menus in the Vantage Cloud Port Setup 
dialog.

Verify your credentials carefully in all places. If credentials are entered incorrectly in any 
of these locations, Vantage Cloud Port may not function properly.

To review your cloud storage and Telestream Cloud configurations, see Creating a Cloud 
Storage Account and Creating a Telestream Cloud Account.

To review your Vantage settings, see Adding your Telestream Cloud Account to Vantage 
and Adding your Cloud Storage Account to the Vantage Folder Address Book for details.
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Deploying Hosted Workflows to Telestream Cloud
Deploying hosted workflows to your account in Telestream cloud is a two-step process. 
First, you validate and export it from Vantage using Workflow Designer; next, you 
import it into Telestream Cloud. This topics describes how to validate and export the 
workflow. Importing a hosted workflow into Telestream Cloud’s Cloud Port web app is 
described in Importing New Workflows into Telestream Cloud.

When you export a hosted workflow from Workflow Designer, two processes are 
initiated automatically: first, the workflow is audited to insure that it meets the criteria 
for a Cloud Port workflow, and second, it is converted to a Compiled Workflow 
Document and saved on your local file system as a file with CWD extension.

Here are the steps:

1. After creating (or updating) your workflow and testing it for proper execution, 
choose File > Export Workflow for Cloud or right-click the workflow and choose 
Export for Cloud.

Workflow Designer automatically audits the workflow to determine if the actions 
and their configurations are supported for use in a hosted workflow. 

If it discovers an error, Workflow Designer displays an error message identifying the 
problem:

Fix the problem and retry.
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 When the workflow passes the hosted workflow audit and is validated for hosting 
and execution in Telestream Cloud, Workflow Designer displays a File Save dialog:

2. Browse to the local or network location you want the file exported to, name the file 
(with the CWD) extension and click Save.

Note: When the export is complete, your work in Vantage is complete. Log into your 
Telestream Cloud account to import the CWD file and prepare it for deployment and 
utilization in Telestream Cloud.
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Troubleshooting
The following tips may help you resolve issues with using Cloud Port features. If you 
cannot resolve a problem on your own, please contact Telestream Support for 
assistance (see Contacting Telestream).

Errors When Enabling Cloud Port Mode on an Action
If Vantage displays an error message when trying to select Cloud Port mode in a cloud-
capable action, the likely cause is that your Telestream Cloud account has not been 
entered in the Vantage Management Console > Settings & Options > Telestream Cloud 
tab. If you have entered the account, click the Test button to verify that your account 
credentials are correct and retry.

Connection Failures
An easy way to recognize if Vantage is connecting with Telestream Cloud and accessing 
third-party storage is that the white cloud logo and the green price indicator both 
show up on the action. If Vantage fails to connect with Telestream Cloud or your cloud 
storage, as indicated by the absence of the logo and price on the action, check your 
credentials in every location where they are entered. 

Cloud-capable actions require credentials in all of these locations:

• Telestream Cloud

• Third party cloud storage

• Vantage Management Console > Settings & Options > Telestream Cloud

• Vantage Management Console > Vantage Folder Address Book

• Action Cloud Port mode > Vantage Cloud Port Setup selections.

Cloud and Storage Performance Considerations
If you have intermittent slow performance issues, consider these suggestions:

• Performance may vary by the type of storage resource you choose. 

• Network traffic during busy times of day may affect cloud and storage performance 
and transfer speeds.

• Cloud storage can become temporarily unavailable. If Cloud Port has trouble 
accessing your storage, visit your storage web site to determine whether your stor-
age is inaccessible for some reason. Also be sure to verify your credentials.

• Default storage account settings specify limits on various available resources. If you 
bump up against the limits and need greater speed or additional storage, contact 
your storage provider for assistance.
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Cloud Storage Is Overloaded by Uploads
The Telestream Cloud Service Upload Limit throttles concurrent uploads to prevent 
overloading cloud storage (default: 4 concurrent files). Use the Vantage Management 
Console > Services panel to select the service, put it into maintenance mode. Now, 
display the Cloud service Setup tab to access and change the Upload Limit value.

The total of this number for all nodes should be set to match the concurrent job limit 
set by Telestream Cloud (30 is the default).

Also, if a large file fails to upload automatically, try this workaround: Use a Copy action 
before the cloud-capable action to manually copy the file to the cloud.

Monitoring Job Status
You can manage hybrid workflow jobs in all of the same ways you normally would in 
Vantage. Use the Workflow Designer Job Status tab to get error messages and use the 
controls to Stop, Restart, or Delete jobs. 

You can also view job status in the Telestream Cloud dashboard. Log in and click the 
Dashboard > Vantage Cloud Port to see the hybrid jobs action list and hosted jobs list. 
Click on any job for details. Error messages in the status details will give you clues as to 
faulty workflow or action settings. 

Font Issues in Subtitles
Cloud-capable actions render fonts differently than actions executing on premises, 
because Cloud servers use Linux instead of Windows. Subtitles or other on-screen print 
renderings that use the fonts built into on premises Vantage OS may result in print 
output from the cloud (Linux) that differs from the same output on Windows. In 
particular, font size, font spacing, font effects and anti-aliasing may have subtle 
differences between the two platforms. If you require a specific font style with Vantage 
Cloud Port, Telestream recommends waiting until NewBlue support is added to Linux.

Pausing Actions in Cloud Port Mode not Supported
Actions operating in Cloud Port mode can not be paused and will not respond to a 
Pause command.

Processing Time-Outs
Cloud-capable actions are optimized for execution efficiency in Telestream Cloud. 
However, if you have unusually large files or other factors that require heavy resource 
usage, it is possible that processing may time out after an extended time period. If this 
happens, please contact Telestream Support for assistance (see Contacting Telestream).

Reference and CML File Limits
If a reference or CML file that references more than 32 files is submitted to a cloud-
capable action, the job will fail at run time, indicating that this is not supported.
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Managing and Using 
Workflows in Telestream 
Cloud

This chapter describes how to use the Cloud Port service via the Cloud Port web app to 
import workflows into Telestream Cloud and manage revisions. This chapter also 
describes how to submit jobs to hosted workflows, monitor cloud based actions and 
workflows, monitor analytics, and set up job notifications.

While most of the tasks you need to perform when utilizing Cloud Port workflows are 
implemented in the Cloud Port web app, they are also implemented in the Cloud Port 
API, enabling you to implement Cloud Port workflow processing in your own systems 
or programs.

Topics
■ Logging in to the Cloud Port Web App

■ Importing New Workflows into Telestream Cloud

■ Managing Hosted Workflow Revisions

■ Submitting Jobs to a Hosted Workflow

■ Monitoring and Managing Action Jobs

■ Monitoring and Managing Hosted Workflow Jobs

■ Monitoring Financial Information

■ Managing Notifications

■ Troubleshooting

Note: Before you can process media in Telestream Cloud, you must have set up your 
Telestream Cloud account, a third-party cloud storage account, and your Vantage 
domain settings for Cloud Port operation as explained in Getting Vantage Cloud Port 
Up and Running.
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Logging in to the Cloud Port Web App
To use the Cloud Port web app, open the Chrome web browser and log into your 
Telestream Cloud account to display the dashboard:

 

In the dashboard menu (blue, in the upper left corner), choose Vantage Cloud Port:

Or, on the dashboard, locate the Vantage Cloud Port panel and click Go To Service.

Telestream Cloud displays the Cloud Port web app’s menu on the left, and the default, 
Jobs Overview panel, to the right:

Use the Cloud Port menu (top left) to display each of the main panels where you 
perform all of your tasks in the Cloud Port web app.

Choose Vantage Cloud Port to 
display the Cloud Port Web app. 

https://cloud.telestream.net
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Importing New Workflows into Telestream Cloud
Deploying hosted workflows in Telestream cloud is a two-step process. First, you create 
and export the workflow from Vantage, using Workflow Designer (see Creating and 
Deploying Hosted Workflows). Next, you import it into Telestream Cloud, where it is 
referred to as a hosted workflow. The original workflow (which is not referred to as 
hosted) can continue to be utilized directly in Vantage as well, if required.

Topics
■ Creating a Hosted Workflow

■ Hosted Workflow Tutorial

Note: This topic describes how to import new workflows—not workflows that have 
been revised. When you revise an existing workflow and export the new version, if you 
were to import it using this method, it would be treated as a separate workflow—
which may, in fact, be exactly what you want to do. 
However, if you want to associate the revision(s) with the original so that you can 
manage them collectively, you should import it as a revision. To learn how to import 
and manage workflow revisions, see Managing Hosted Workflow Revisions.

Creating a Hosted Workflow
To import a CWD workflow file, perform these steps:

1. In the Cloud Port web app, display the Workflows panel.

2. Click New Workflow.

3. Configure the following fields (all are required):

Workflow Name (max. 255). Descriptive name for this workflow.

Workflow Document (max. 255). Enter the fully-qualified file path (in UNC | drive 
letter format) or Browse to locate and choose the on-premises CWD file.

Default Store. Specifies the store where source media is located. Workflows 
exported from Workflow Designer for hosting in Telestream Cloud don’t include the 
storage location or subfolder, since they are independent of Telestream Cloud.

Stores are managed at the Telestream Cloud level. To view and manage stores, 
choose Manage Stores from the Telestream Cloud main menu.

Note: Optionally, specify a subfolder/folder offset and modify the default store. After 
creating a hosted workflow, you can modify the default store and add a subfolder 
offset: Click Workflows > (Target Workflow) > Details tab. Click the Gear icon for the 
Store to update the default store. Click the Gear icon for the Folder Offset to specify an 
optional subfolder string.

4. When the file has been uploaded, click Create Workflow to validate it and activate it 
for use.
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Hosted Workflow Tutorial
This tutorial describes how to import CWD files that have been exported from Vantage 
Workflow Designer to an on-premises location on your network.

1. On the Dashboard, choose Vantage Cloud Port from the menu to display the 
Vantage Cloud Port web app:

2. In the Vantage Cloud Port panel, choose Workflows to display the Workflows panel:

This panel displays workflows that have already been deployed, and enables you to 
add new ones to your account.
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3. Click New Workflow to display the New Workflow panel:

4. Configure the following fields (all are required):

Workflow Name (max. 255). Enter the descriptive, display name for this workflow. 
Workflow names must be unique within the Cloud Port service, but the name you 
enter does not have to match the name used in Vantage Workflow Designer. This 
name is displayed anywhere that this workflow or its jobs are referenced in the web 
app.

Workflow Document (max. 255). Manually enter the fully-qualified file path and 
name in Windows UNC or drive letter format, or click Browse to locate and choose 
the on-premises CWD file you exported from Workflow Designer. CWD files must be 
local or network accessible.

Default Store. Name of the store where source media for this workflow is located.

Note: If no stores are available, it indicates that no cloud storage locations have 
been defined in your Telestream Cloud account. You must add at least one cloud 
storage location in order to utilize hosted workflows. 
To create a new store, choose Add New Store. Select the platform for the store, 
configure it and click Add Store at the bottom of the panel.)

5. Next, click Create Workflow to upload it into Telestream Cloud.

Telestream Cloud uploads the file to the target store. Progress is indicated to the 
right of the Workflow Document field. 
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6. When uploading is complete, click Create Workflow to deploy it for use:

Telestream Cloud notifies you when deployment is complete and displays the new 
workflow in the Workflows table:

Summary

You’ve now completed the second half of the hosted workflow Design and Export / 
Import and Deploy process. Your hosted workflow is now ready to go to work!
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Managing Hosted Workflow Revisions
During the life cycle of a workflow, modifications are often made to adapt it to 
changing requirements. Cloud Port supports workflow versioning; enabling you to 
import multiple revisions of the same workflow, and activate a specific version at any 
point in time. The active version is always utilized when you interact with the workflow.

Note: This topic describes how to import modified workflows—workflows that have 
been modified and a new version exported. Telestream suggests importing updated 
workflows as a revision, so that they are directly associated with the original and you 
can manage the revisions effectively. Telestream does not recommend proliferating 
workflow revisions by the method described in Importing New Workflows into 
Telestream Cloud, as each revision would be a separate, independent workflow.

Using workflow revisions in Cloud Port may be very useful. However, Workflow 
Designer does not support revisions. Therefore, before revising a workflow for use in 
Cloud Port as a hosted workflow, best practice suggests that you duplicate the 
workflow in Workflow Designer and then make changes to the duplicated version, to 
maintain previous versions that are still deployed in Telestream Cloud.

Importing a Revised Workflow
To import a new version of an existing workflow, follow these steps:

1. Click Workflows and then choose the workflow you want to revise. Cloud Port 
displays its workflow panel:
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2. Choose Add Revision from the menu (upper right corner):

3. Choose Add Revision to display the Add Revision dialog:

4. Click Browse to navigate to and choose the CWD file and import it as a version of 
the original workflow. Optionally, enter a comment to provide a description of the 
revised workflow:

5. When upload is complete, click Add to deploy the revised workflow.
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6. Click the Details tab to display all revisions of this workflow:

The Revisions table displays the new version Cloud Port just created. Click Make Default 
to make this the active revision. Use the Revision menu to display details about a given 
revision or set it to All to display all revisions of this workflow.

Here are the workflow revisions following the upload of a new revision:

In this example, the original (ID 1) version (uploaded on April 14th) is currently active.

The new (ID 2) version’s status is Staging to indicate that it is not currently in use.

Note: The comment entered when this revision was added explains what changed.
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Switching Between Workflow Revisions
When a workflow has multiple revisions, you can switch between them, making any 
revision active at any time. The active revision may have different variables and 
expected inputs that are used in the workflow.

For example, when the original revision (Revision ID 1) is selected, the details of this 
workflow are displayed:

If you select the 2nd revision, then the new changes (for example, the newly added 
variable) display:

The variable which was added to this version of the workflow is now displayed. Also note 
that the Make Default and Delete buttons are now enabled:

These controls are only enabled for revisions which are not currently active.



Managing and Using Workflows in Telestream Cloud
Managing Hosted Workflow Revisions

73

Make Default. This revision is made the default or active revision of the workflow.   Any 
API-based interaction with this workflow or any job submission via the Cloud Port web 
app will use this revision of the workflow, including expected variables and sources 
particular to this revision.

Delete. This workflow revision is permanently removed from Telestream Cloud.
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Submitting Jobs to a Hosted Workflow
To submit a job to a hosted workflow, follow these steps:

1. To submit a job to a hosted workflow, display the Workflows panel:

2. Choose the workflow to which you want to submit a job. 

Cloud Port displays the Workflow panel for the selected workflow:

3. Click Submit Job to display the New Job panel, to configure the job requirements:
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4. Complete the following controls:

Job Name (optional). Enter a text string to display in the job list for this workflow. If 
blank, the job name is derived from the file name of the first source.

Variables. For each expected variable in your workflow, specify values for this job. 
(Using Variables and Parameters in Cloud Port Workflows).

Source. For each nickname in this workflow, manually enter or click Browse to 
choose a locally-stored file. Or, use a cloud storage browser utility to choose the 
cloud-stored file and enter a Signed URL to access it. A Signed URL is a special URL 
which enables access to a file located in supported cloud storage (Google Cloud 
Storage | Amazon S3 | Azure BLOB Storage). 

The easiest way to obtain a signed URL is to use a network file utility such as Cyber-
duck to generate a signed URL for the file. For example:
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Browse to a specific bucket in your storage and select the target file. Choose Copy 
URL > Pre-signed URL and paste the URL into the nickname’s Source field.

Storage. Choose the storage (with a manually entered optional subfolder offset/
qualifier) for the output generated by any transcoding actions or other actions that 
require storage in this workflow.

Note: The Storage entry specification also defines the Provider and Region where 
this process should execute. See Creating a Cloud Storage Account for details.

5. Click Submit Job to create a new job for this workflow and begin execution:

Now that you have submitted a job to this hosted workflow, you can monitor its 
progress in the Jobs Overview panel.
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Monitoring and Managing Action Jobs
Hybrid workflows that submit actions to Telestream Cloud for execution are called 
action jobs. Action jobs can be monitored and managed in both Vantage and 
Telestream Cloud. In Vantage, you can focus on the workflow at the workflow level; in 
Cloud Port, you can focus on each Cloud-capable action that executed in Telestream 
Cloud. For information about monitoring jobs in Vantage, read the appropriate topics 
in the Vantage User’s Guide.

To view and manage action jobs—Cloud-capable actions—that have been submitted 
for execution in Telestream Cloud (from both hybrid and hosted workflows), click 
Overview to display the Jobs Overview panel.

The Jobs Overview panel displays action jobs for all actions that are queued, running, 
or complete (in any state). If you have multiple Cloud-capable actions in a single 
workflow, Cloud Port displays a separate entry for each one in the workflow.

As jobs execute, the action status for each Cloud-capable action in that job updates in 
real time.

The action table displays each action job’s Telestream Cloud workflow name, job name, 
the action itself, plus status and start date/time stamp. 

Note: The date/time stamp is in UTC; it displays the UTC value adjusted by the 
browser time zone value, based on the time zone set on your computer. If your 
computer timezone is set to auto-adjust, the displayed value will vary based on your 
location at the time of the inquiry.

You can use the action jobs table to:

• Search for actions—in the search field, enter the workflow or action string and the 
table updates automatically. Clear the field to return to the full list.

• Filter jobs—choose All | Created | In Progress | Completed

• Delete jobs—remove jobs that have completed; click on the trash icon associated 
with the job entry

• Cancel executing actions—click on the trash icon associated with the job entry

• Display action job details—click on the workflow name or Vantage job name to dis-
play the Job Details panel (Viewing Action Job Details).
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Viewing Action Job Details
Choose a job in the Jobs table to display the Job Details panel for this action:

The Job Details panel displays the following information:

Workflow Name. The Vantage name of the workflow that contains this action.

Job Name. The display name of the job that was submitted in Vantage for execution.

Started. The date/time stamp when the action began execution in Telestream Cloud.

Output Store. The cloud location where the output is written to.

Inputs—Outputs. The number of input files and output files defined in this action.

Action. The Vantage display name of this action, including the version number.

Processing Time. The elapsed time of execution.

Estimated Cost. The estimated cost of execution, in US dollars. The estimated cost is 
based on the duration of the output media and the features used in the action.

Job ID. The UUID assigned for this action job.

Note: Use the action job ID when utilizing this job via the API. You should also include 
the action job ID when a problem is being reported to Telestream Customer Service. 
Click the Copy icon to copy the job ID to the clipboard for use elsewhere.

Status. The status of the action:

Queued—Telestream Cloud is waiting for cloud resources on which to execute the job.
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Downloading—The cloud server running the execution container is acquiring the 
source files required to start the job.

Processing—The job is being executed.

Uploading—The output from the job is being uploaded back to your specified cloud 
storage location.

Successful—The job completed successfully.

Failed—The job encountered a problem during execution. See details of the job for 
error messages.

Inputs Tab
The Inputs tab lists each input file utilized by this action. The input is listed by 
nickname, and includes file size, duration, and link to a signed URL, which you can copy 
(click on the copy icon) for use in accessing this file.

If the signed URL is current, the link is the file name and you can click it to view the file. 
If the URL has expired, the filename is replaced by the nickname.

Output Tab
The Outputs tab conversely, lists each output file created by this action. The output is 
listed by nickname, and includes file size, duration, and URL, which you can copy (click 
on the copy icon) for use in accessing this file.

If the signed URL is current, the link is the file name and you can click it to view the file. 
If the URL has expired, the filename is replaced by the nickname.

Related Jobs
The Related Jobs tab displays other jobs that have the same Vantage job ID when the 
job was submitted. The jobs are listed by job name, and include the action and status.
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Reviewing Completed Hybrid Workflow Jobs
When the job completes, check Vantage Job Status for success or failure. If there is a 
failure, Vantage Job Status and your Telestream Cloud account provide details about 
what happened. 

1. Finally, check the binder (right-click the job and select View Binder) and the cloud 
storage for expected output files (AWS S3 example shown). 

2. In Telestream Cloud, open the Cloud Port web app.
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3.  Click Overview to display the Jobs Overview panel and all action jobs.

4. Click the Workflow Name or Vantage Job Name to view job details for the target 
action.

5. Finally, check the cloud storage for expected output files (AWS S3 example shown). 
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Monitoring and Managing Hosted Workflow Jobs
Hosted workflows can only be monitored in Telestream Cloud or via an API-based 
program. Jobs for hosted workflows are referred to as workflow jobs in the context of 
Cloud Port.

Topics
■ Overview

■ Viewing Hosted Workflow Details and Jobs

■ Displaying Workflow Details

Overview
To view and manage hosted workflows, click Vantage Cloud Port > Workflows to display 
the Workflows panel:

The Workflows panel displays a table of workflows. 

Importing a New Workflow—To import and deploy a hosted workflow after its been 
exported from Vantage Workflow Designer, click New Workflow (see Importing New 
Workflows into Telestream Cloud). 

Using the Workflows Table—This table displays hosted workflows that have been 
deployed in Telestream Cloud. Workflows are listed by workflow name, and include 
status, number of active jobs, and number of jobs in the last 30 days.

Use the workflows table to:

• Search for workflows—in the search field, enter workflow or action string.

• Filter workflows—choose Active | Archived | All

• Monitor the number of active jobs—the value displayed represents the number of 
jobs concurrently running in this workflow.

• View workflow status—Invalid | Active | Staging | Archived.
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• Archive | Unarchive a workflow—click on the Down arrow icon associated with the 
workflow to archive it. Click on the Up arrow icon to unarchive it. When a workflow 
has been archived, you can not submit jobs to it or its active revision.

• Delete a workflow—click on the trash icon associated with the workflow entry to 
permanently remove it.

• Display related jobs and details—click on the workflow name to display jobs and 
details for this workflow. See Viewing Hosted Workflow Details and Jobs.

Viewing Hosted Workflow Details and Jobs
Cloud Port provides details similar to Vantage related to jobs it has processed.

Displaying Workflow Details
To display a workflow’s details, display the Details tab:

Metadata in the details pane applies to the workflow generally, and its revisions, if any.

ID. The workflow ID is used to identify and reference the workflow in all API operations. 
Click Copy to copy the workflow ID for use in API-based programs. 

Name. The display name of the workflow, assigned when the workflow was imported.

Vantage Workflow Name. Display name of the workflow in Vantage Workflow 
Designer.

Created at. Date/time stamp when the workflow was imported into Telestream Cloud.
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It also provides other details by category: the default store, expected variables, sources, 
and storage references. All of this information is extracted from the Vantage workflow 
configuration.

Setting the Default Store
The default store pane displays the store and subfolder/offset, if any, used by this 
workflow.

Store. Choose the store to use for actions in this workflow that generate files. (The 
Cloud Storage and subfolder path defined in Vantage for this workflow are not valid in 
Telestream Cloud and must be specified when you import a workflow (see Creating a 
Hosted Workflow).

Folder Offset. Choose the store to use for actions in this workflow that generate files. 
(The Cloud Storage and subfolder path defined in Vantage for this workflow are not 
valid in Telestream Cloud and must be specified when you import a workflow (see 
Creating a Hosted Workflow

Expected Variables. Variables utilized in the workflow whose value is not provided by 
the workflow itself or by the default value of the variable. Provide default values here. 
You can override them when you submit a job.

Sources. Displays the sources defined in this workflow, by nickname and description. 
To change source definitions, edit the workflow in Workflow Designer and re-import it 
as a new workflow or as a workflow revision.

Storage References. For each action in the workflow, you can define a separate 
storage location and offset. 
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Displaying Workflow Jobs Details
To display jobs associated with a hosted workflow, display its Jobs tab:

The Job tab displays a list of jobs associated with this workflow by job name, plus 
status, cloud action, and a time stamp.

You can use the table to:

• Search for jobs—in the search field, enter a string to search in the job name

• Filter jobs—choose All | Created | Created | In Progress | Succeeded | Failed

• Check cloud action status—during execution, click on the action name to display a 
progress bar

• Delete a job—click on the trash icon associated with the job entry

• Display jobs and details—click on the job name. For information, see Viewing 
Hosted Workflow Details and Jobs and Displaying Workflow Details.

Renaming a Workflow
Renaming a workflow simply changes its display name. It has no other effect.

To rename a workflow, follow these steps:

1. Click Workflows and then choose the workflow you want to revise. 

Cloud Port displays its workflow panel.

2. In the Workflows menu, select Rename Workflow. 

3. In the Rename Workflow dialog, enter the new name for this workflow and click 
Save.
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Archiving and Unarchiving Workflows
Archiving a hosted workflow renders it—or its active revision, in the case of a workflow 
with revision—unable to accept new jobs. If you only want to deactivate a revision of a 
workflow, use Switching Between Workflow Revisions instead.

Unarchiving a workflow returns it (or its active revision) to a normal state where it can 
accept jobs and execute.

Archiving a Workflow
To archive a workflow, follow these steps:

1. Click Workflows to display the Workflows panel.

2. Choose the workflow you want to archive. Cloud Port displays its panel.

3. In the Workflows menu, select Archive Workflow.

4. In the Rename Workflow dialog, enter the new name for this workflow and click 
Save.

5. When you archive a workflow, its panel is bannered with an Archive notice.

Unarchiving a Workflow
To unarchive a workflow, follow these steps:

1. Click Workflows to display the Workflows panel.

2. Show archived workflows to view only workflows that have been archived.

3. Choose the workflow you want to return to use. Cloud Port displays its panel.

4. In the Workflows menu, select Un-archive Workflow.

5. When you un-archive a workflow, the Archived banner is removed and the 
workflow can now execute jobs.

Deleting a Workflow
Deleting a workflow permanently removes it and all revisions from Telestream Cloud.

To delete a workflow, choose one:

Display the Workflows click the trash icon for workflow you want to delete, and confirm 
your decision in the dialog.

—OR— 

In the selected workflow’s panel choose Delete Workflow from the menu and confirm 
your decision in the dialog.

Exporting a Hosted Workflow
You can export a hosted workflow in CWD format; returning it to the same format 
exported by Vantage Workflow Designer. 



Managing and Using Workflows in Telestream Cloud
Monitoring and Managing Hosted Workflow Jobs

87

Among other purposes, you can use CWD files for:

• External archiving

• Transfer to other Telestream Cloud accounts

• Importing into Vantage

 To export a hosted workflow, follow these steps:

1. Click Workflows to display the Workflows panel.

2. Choose the workflow you want to export. Cloud Port displays its panel.

3. In the Workflows menu, select Download CWD.

4. Chrome downloads the workflow file in Vantage CWD format as a JSON file and 
stores it in your Downloads location (Settings > Advanced > Downloads). When the 
process completes, displays an entry at the bottom of the window. Click on it to 
open the file or show it in its folder.
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Monitoring Financial Information
The Analytics panel provides you a financial breakdown of the cost of Cloud Port 
workflow processing by workflow and action. (Due to rounding of display values, the 
sum may vary slightly from the Total Cost entries.)

 

The Analytics table displays workflows and cloud actions, and the cost associated with 
its usage.

On this panel you can:

• Change the Date Range—click in the Date Range field, then select the Period Begin 
date and the Period End date and click OK.

• Organize line items—click Show Filters and group them by Action | Filter | Domain 
ID.

• Organize line items—click Show Filters and filter them by Workflow Name | Action 
Name | Features Name | Domain ID.

The Feature value is the SKU of the Telestream Cloud component utilized. The 
Domain ID is the numeric identity of the Vantage domain from which the workflow 
originated.
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Managing Notifications
Notifications enable Cloud Port—and other Telestream Cloud services—to send alerts 
when certain events occur. 

Note: Notifications can also be viewed and managed at the Telestream Cloud level by 
selecting Notifications from the main menu. The table displays notifications at this 
level for all services in Telestream Cloud.

 

The Notification panel displays a table of notifications that have been created. Each 
entry is listed by event, deliver method (type), and end point (for example, email 
address or URL).

On this panel you can:

• Create new notifications—click Add Notification to create a new one.

• View and update notification settings—click the Gear icon for the target notifica-
tion.

• Delete Notifications—click the trash icon of the target notification to permanently 
remove it.

Adding Notifications
To add a new notification, perform these steps:

1. To add a notification—on the Notifications panel, click Add Notification. 

2. On the Add Notification panel, complete these fields:

• Service. Defaults to Vantage Cloud Port. 

• Store. Specifies which store (or all stores) this notification is intended for. (Stores 
are created and managed in Telestream Cloud via the main menu > Manage 
Stores).

• Delivery Method. Choose the delivery method: webhook | email | Amazon Simple 
Notification Service (SNS) | Azure Event Grid | Google Cloud Pub/Sub. 
Based on the delivery method, configure the notification to function as required.

• Available Events. Check one or more events to trigger the notification.

3. Click Create to save the notification you just configured and activate it.
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Editing Notification Method Settings
Changes to an existing notification are limited to configuration settings of the specified 
delivery method—you can’t change the service, store, or delivery method.

To edit an existing notification, perform these steps:

1. On the Notifications panel, click the Gear icon for the target notification.for the 
target notification.

2. On the Add Notification panel, make changes to the delivery method’s 
configuration controls and field:

3. Click Save to update the notification and re-activate it.
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Troubleshooting
The following tips may help you resolve issues with using Cloud Port features. If you 
cannot resolve a problem on your own, please contact Telestream Cloud Support for 
assistance (see Contacting Telestream).

Connection Failures
An easy way to recognize if Vantage is connecting with Telestream Cloud and accessing 
third-party storage is that the white cloud logo and the green price indicator both 
show up on the action. If Vantage fails to connect with Telestream Cloud or your cloud 
storage, as indicated by the absence of the logo and price on the action, check your 
credentials in every location where they are entered. 

For a cloud-capable action to work, the required credentials must be correct in all of 
these locations:

• Telestream Cloud

• Third party cloud storage

• Vantage Management Console > Settings & Options > Telestream Cloud

• Vantage Management Console > Vantage Folder Address Book

• Action Cloud Port mode > Vantage Cloud Port Setup selections.

Cloud and Storage Performance Considerations
If you have intermittent slow performance issues, consider these suggestions:

• Performance may vary by the type of storage resource you choose. 

• Network traffic during busy times of day may affect cloud and storage performance 
and transfer speeds.

• Cloud storage can become temporarily unavailable. If Cloud Port has trouble 
accessing your storage, visit your storage web site to determine whether your stor-
age is inaccessible for some reason. Also be sure to verify your credentials.

• Default storage account settings specify limits on various available resources. If you 
bump up against the limits and need greater speed or additional storage, contact 
your storage provider for assistance.
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Cloud Storage Is Overloaded by Uploads
The Cloud Service has an Upload Limit that throttles concurrent cloud file uploads to 
prevent overloading your cloud storage. The default is four concurrent files. 

To view or change the upload limit, follow these steps:

1. Open the Vantage Management Console

2. Choose Services from the Component panel on the left.

3. In the Services panel, choose the Cloud Service and set it to maintenance mode.

4. Display the Setup tab and change the Upload Limit value and click Apply.

5. Bring the Cloud Service back online.

If a large file fails to upload automatically, try this workaround: Use a Copy action before 
the cloud-capable action to manually copy the file to the Cloud before processing it.

Font Issues in Subtitles
Cloud-capable actions render fonts differently than actions executing on premises, 
because Cloud servers use Linux instead of Windows. Subtitles or other on-screen print 
renderings that use the fonts built into on premises Vantage OS may result in print 
output from the cloud (Linux) that differs from the same output on Windows. 

In particular, font size, font spacing, font effects and anti-aliasing may have subtle 
differences between the two platforms. If you require a specific font style with Vantage 
Cloud Port, Telestream recommends waiting until NewBlue support is added to Linux.

Processing Time-Outs
Cloud-capable actions are optimized for execution efficiency in Telestream Cloud. 
However, if you have unusually large files or there are other factors that cause 
significant resource usage, it is possible that processing may time out after an extended 
period. A job that self-terminates displays an error message.

If this happens, contact Telestream Support for assistance (see Contacting Telestream).
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